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Technically,	Windows	users	cannot	use	macOS	on	their	PCs.	Furthermore,	newer	Macs	with	the	Apple	silicon	chip	cannot	run	Windows.	But	thanks	to	the	development	of	emulators	and	virtualization	tools,	it	is	possible	for	users	of	both	platforms	to	use	one	operating	system	together	with	another.	Ive	rounded	up	four	Windows	emulators	on	Mac	to
help	you	decide	which	one	to	use	to	install	the	Windows	operating	system,	apps	and	games	on	your	Mac.	Emulators	allow	you	to	reproduce	the	function	or	action	ofa	Windows-based	PC	on	your	Mac	through	virtual	machines	and	guest	operating	system	images.	To	put	it	simply,	a	Windows	emulator	is	a	tool	that	lets	you	run	software	or	applications
(including	games)	that	are	otherwise	not	compatible	with	your	computers	operating	system	or	chip	architecture.	Hence,	a	Windows	emulator	for	Mac	allows	you	to	run	Windows	11,	for	example,	on	your	Mac.	This	enables	you	to	install	and	use	Windows	apps	as	well	as	play	many	Windows-based	games.	The	first	and	possibly	the	easiest	emulator	to	use
included	on	our	list	isnt	really	an	emulator	at	all.	This	would	be	Apples	Boot	Camp.	It	comes	preinstalled	on	Intel-based	Mac	computers,	and	its	free	to	use.	You	can	access	Boot	Camp	through	the	Utilities	folder	in	your	Macs	Applications	folder.	Boot	Camp	allows	you	to	install	Windows	on	your	Mac.	Once	installed,	you	can	dual-boot	both	Windows	and
macOS.	The	good	thing	about	using	Boot	Camp	to	dual-boot	between	Windows	and	macOS	is	that	both	operating	systems	can	fully	utilize	the	power	of	your	Mac	hardware.	It	doesnt	scale	down	the	performance	of	the	two	operating	systems.	Boot	Camp	utilizes	two	partitions	on	your	Macs	hard	disk	to	install	the	two	operating	systems	separately.	So,
when	you	boot	your	Mac,	you	will	be	given	the	option	to	either	boot	into	Windows	or	macOS.	One	letdown	of	Boot	Camp	is	that	it	only	works	with	Intel-based	Macs;	its	not	compatible	with	the	newer	Apple	Silicon	Mac	computers.	Availability:	Free.	Pros	Free	and	built-in	to	macOS.	Delivers	a	fast	and	more	stable	performance.	Cons	Its	not	a
virtualization	tool,	so	you	cant	run	macOS	and	Windows	at	the	same	time.	Takes	up	a	lot	of	space.	You	wont	be	able	to	change	the	partition	size	of	your	Mac	HD	once	installed.	Another	popular	emulator	that	lets	you	run	Windows	on	your	Mac	is	Parallels	Desktop.	Its	a	visualization	tool	that	allows	you	to	create	a	virtual	machine	where	you	can	install
Windows,	and	then	install	apps	and	play	games.	Compared	to	Boot	Camp,	Parallels	Desktop	allows	you	to	run	Windows	within	macOS.	This	means	you	dont	have	to	reboot	your	Mac	anytime	you	want	to	switch	between	the	two	operating	systems.	Another	difference	between	Parallels	Desktop	and	Boot	Camp	is	the	fact	that	it	is	compatible	with	Apple
Silicon	Macs.	It	might	even	work	better	with	those	Macs.	Availability:	$99.99	annual	subscription	fee.	A	free	trial	is	available.	Pros	Smooth	graphics	performance.	Lets	you	install	macOS	from	the	recovery	partition	of	Intel-based	Macs.	Faster	than	its	rivals.	Runs	ARM-based	Windows	on	Apple	Silicon	Macs.	Cons	Not	as	stable	as	VMWare	Fusion.
Integrations	between	Windows	guest	and	Mac	host	can	become	quite	confusing.	VMWare	Fusion	is	similar	to	Parallels	Desktop.	Its	also	a	virtualization	tool	that	lets	you	run	Windows	OS	within	macOS.	Hence,	no	rebooting	is	needed	to	switch	between	Windows	OS	and	macOS.	VMWare	Fusion	allows	you	to	use	your	Mac	apps	in	the	background	while
you	use	Windows	OS.	And	when	youre	using	Windows,	you	can	expand	into	full	window	mode,	allowing	you	to	run	apps	easily	and	enjoy	playing	your	favorite	Windows	games.	One	good	thing	to	note	about	VMWare	Fusion	is	its	Unity	Mode.	This	lets	you	run	Windows	Explorer,	Windows	equivalent	to	Finder,	as	an	app	in	macOS.	Availability:	$149	(30-
day	trial	free	version	is	available).	Pros	Supports	virtualization	of	any	Intel-compatible	OS	and	macOS.	A	free,	limited-feature	version	is	available	for	personal	use.	The	virtual	machine	runs	on	Macs,	Windows,	and	Linux	hosts.	Cons	May	run	slower	than	Parallels	Desktop.	Lacks	support	for	ARM-based	guests	or	hosts.	VirtualBox	is	another	tool	that	lets
you	create	a	virtual	machine	to	install	Windows	on	your	Mac	without	the	need	to	reboot.	Its	freely	available	for	personal	and	educational	uses.	But	for	businesses,	a	paid	version	is	offered,	which	comes	with	technical	support	and	more	features.	These	also	include	support	for	Mac	hardware	such	as	the	camera,	connected	printers,	and	other
peripherals.	But	as	it	is,	the	free	version	has	been	proven	to	be	stable	enough	to	run	Windows	apps,	games,	audio,	and	3D	graphics.	The	only	letdown	is	that	VirtualBox	can	be	rather	difficult	to	set	up.	But	with	patience,	Im	pretty	sure	youll	be	able	to	run	it	smoothly.	Availability:	Free	for	personal	and	educational	users.	A	paid	version	is	available	for
businesses.	Pros	Offers	an	unlimited	number	of	snapshots.	Easy	to	install	and	takes	less	storage	space.	Can	detect	USB	devices.	Cons	Offers	limited	support	for	3D	graphics.	The	user	interface	needs	improvement.	I	intentionally	did	not	include	Wine	and	CrossOver	on	the	list	simply	because	both	of	them	only	allow	you	to	install	apps	and	games	on
your	Mac	without	the	need	to	run	Windows	itself	in	a	separate	virtual	machine.	So	if	you	just	need	to	use	Windows	apps	and	play	Windows	games,	these	two	tools	would	serve	the	purpose,	and	serve	it	well.	Wine	is	free	to	use	while	CrossOver	is	available	for	$74.00.	You	might	also	be	interested	in	how	to	download	and	install	CrossOver	23	on	macOS
and	play	any	game	you	want.	Run	Windows	XP,	Mac	OS	9,	Windows	11,	Super	Mario	Bros.	and	more	on	your	Mac.	Screenshot:	D.	Griffin	Jones/Cult	of	Mac	Collecting	old	video	game	consoles	and	vintage	computers	is	a	fun	hobby,	but	keeping	all	that	hardware	working	can	quickly	become	an	expensive,	never-ending	task	not	to	mention	all	the	space
you	need	just	to	store	the	gear.	You	might	instead	(wisely)	opt	to	play	your	favorite	games	and	software	using	emulators	for	your	Mac.In	this	guide	to	Mac	emulation,	Ill	walk	you	through	the	best	apps	you	can	use	to	accomplish	the	two	most	common	scenarios:	playing	old	video	games,	and	taking	Classic	Mac	OS	for	a	test	drive	on	a	modern	Mac.
Plus,	Ill	wrap	up	with	the	easiest	way	to	virtualize	modern	operating	systems	like	Windows	and	Linux	on	your	Mac.	(This	handy	virtualization	software	also	works	for	old	and	obscure	computer	operating	systems.)Best	of	all,	each	of	these	Mac	emulation	methods	is	free	and	open	source.	Play	retro	video	games	and	use	old	computers	with	emulators	for
your	MacYou	can	watch	a	video	that	walks	through	these	apps	here:1.	OpenEmu	plays	Nintendo,	Sega,	Atari,	Sony	games	and	moreOrganize	and	play	your	favorite	classics	in	OpenEmu.Screenshot:	D.	Griffin	Jones/Cult	of	MacOpenEmu	is,	hands	down,	the	easiest	way	to	play	old	video	games	on	your	Mac.	When	you	first	launch	the	app,	itll	ask	which
consoles	you	want	to	enable.	There	are	dozens	of	options	from	the	1980s,	90s	and	2000s	including	some	obscure	ones	like	the	Vectrex	and	the	ColecoVision.Effectively,	its	a	user-friendly	interface	on	top	of	a	bunch	of	separate	emulators	that	you	would	otherwise	need	to	spend	an	hour	or	more	each	setting	up.	But	with	OpenEmu,	you	can	download
ROM	files	online	copy	ROM	files	from	game	cartridges	you	already	own	and	simply	drag-and-drop	them	into	the	app	to	add	them	to	your	library.Then,	you	just	double-click	on	a	game	to	launch	it.	You	can	customize	the	controls	for	your	Macs	keyboard	or	use	a	connected	controller.	And	you	can	easily	create	save	states	to	pick	up	where	you	left	off.
You	can	even	use	a	shader	to	simulate	the	blurring	effect	of	a	CRT	television	for	old	console	games	or	the	pixellated	LCD	of	a	GameBoy	Color.The	games	will	automatically	sort	into	categories	by	console;	you	can	create	your	own	collections,	too.Download	from:	OpenEmu2.	Classic	Mac	OS	emulators	for	your	web	browserPoke	around	Classic	Mac	OS
with	Infinite	Mac.Screenshot:	D.	Griffin	Jones/Cult	of	MacInfinite	Mac	is	the	easiest	way	to	tool	around	with	early	versions	of	Mac	OS,	because	theres	no	installation	needed.	Using	the	magic	of	WebAssembly,	these	open	source	virtual	machines	run	straight	inside	any	modern	web	browser.	You	can	set	up	all	manner	of	combinations	of	Apple	system
software	with	the	classic	Mac	of	your	choice.All	the	installations	come	with	some	of	the	most	popular	apps	and	games	of	the	era	in	which	the	Mac	OS	was	released:	MacWrite	and	MacPaint,	Photoshop,	Microsoft	Word,	KPT	Bryce,	Marathon,	Another	World,	SimCity,	Lemmings,	Civilization	and	more.You	can	add	your	own	software	that	you	find	online
from	sites	like	Macintosh	Garden	with	a	simple	drag-and-drop.	Infinite	Mac	will	treat	it	like	youre	inserting	a	floppy	disk.Save	your	work	by	putting	files	in	the	Outside	World	folder,	which	will	be	downloaded	instantly	to	your	Mac.Use	it	at:	Infinite	Mac	website3.	UTM	virtualizes	modern	operating	systemsUTM	is,	hands	down,	the	best	of	all	computer
emulators	for	Mac,	for	running	software	old	and	new.Screenshot:	D.	Griffin	Jones/Cult	of	Mac	UTM	is	the	easiest	way	to	emulate	or	virtualize	modern	operating	systems	on	a	Mac.	Its	night	and	day	easier	to	set	up	than	VirtualBox,	which	has	sucked	away	many	frustrating	hours	of	my	life	that	I	will	never	get	back.Unlike	VirtualBox,	adding	a	new
virtual	machine	using	UTM	is	as	simple	as	clicking	a	couple	of	buttons.	After	you	download	the	free	software,	just	hit	the	+	and	clickDownload	prebuilt	from	UTM	Gallery.	You	can	download	any	of	the	preset	machines	shown	there	and	boot	them	right	up.Maybe	you	want	to	play	a	classic	PC	game,	like	Quake	III,Rollercoaster	Tycoon	or	SimTower,
inside	Windows	XP.	Or,	you	can	have	an	installation	of	Mac	OS	9	that	runs	locally	on	your	computer.	(Its	more	reliable	than	Infinite	Mac,	which	runs	in	your	web	browser.)	Theres	also	Sun	Solaris	9,	a	unique	operating	system	made	for	workstation	hardware,	thats	just	plain	fun	to	poke	around.UTM	also	can	virtualize	modern	operating	systems	like
Windows	11	for	the	few	PC	programs	you	might	need	to	run.	If	you	use	your	Mac	for	software	development,	you	can	run	all	kinds	of	flavors	of	Linux	Ubuntu,	Fedora,	Debian	and	more.Of	course,	you	can	build	your	own,	if	you	dont	see	what	you	want	in	the	gallery.	On	an	Apple	silicon	Mac,	you	can	virtualize	any	other	version	of	macOS	for	Apple	silicon
(macOS	Monterey	and	newer).	This	could	be	an	essential	tool	for	testing	Mac	apps	on	older	Apple	operating	systems	without	keeping	a	pile	of	MacBooks	in	your	office.I	plan	on	using	UTM	to	make	backups	of	some	of	my	personal	computers,	starting	with	my	beloved	2006	Acer	TravelMate	2430,	for	the	day	when	it	inevitably	fails.Download	from:	UTM
project	website	(free)	or	the	Mac	App	Store	($9.99).We	originally	published	this	article	about	emulators	for	Mac	on	November	18,	2023.	We	republished	it	on	May	29,	2025.	What	are	the	best	Mac	emulators?	Whats	the	best	way	torun	old	software	and	retro	console	games	in	macOS?Software	and	videogames	were	once	on	borrowed	time,	surviving
only	as	long	as	the	hardware	on	which	they	ran.	But	then	systems	became	powerful	enough	to	successfully	mimic	those	that	came	before.	So	began	the	age	of	emulation.Today,	even	a	years-old	Mac	can	emulate	a	huge	range	of	older	hardware,	giving	you	the	chance	to	relive	old	favourites,	or	to	experience	apps	and	games	you	might	have	missed.
Emulation	is	also	vital	from	an	archiving	standpoint,	keeping	safe	countless	pieces	of	software	that	would	otherwise	disappear	forever	as	the	media	theyre	stored	on	degrades.In	this	feature,	we	explore	the	current	state	of	emulation	on	macOS.	We	begin	with	how	to	emulate	old	Apple	hardware	such	as	the	Apple	II	and	Macintosh	Plus.	We	then	delve
into	emulating	ancient	PCs,	classic	consoles,	arcade	games,	and	a	few	much-loved	home	computers.Read	next:	Best	free	web	browser	games	forMac|	Best	Mac	gamesBest	Mac	emulators	guide:	The	obligatory	warnings	bitBefore	we	begin,	its	worth	noting	a	few	snags	relating	to	emulation.	First,	emulation	isnt	always	plug-and-play	but	we	will	outline
how	to	get	started	with	emulators	we	cover.	Secondly,	macOS	may	complain	some	of	our	recommended	emulators	are	from	unidentified	developers,	and	therefore	wont	launch	them.	To	get	around	that,	Control-click	the	relevant	app	in	Finder,	select	Open,	and	click	Open	in	the	subsequent	warning	dialog	box.Finally,	there	are	legal	issues	surrounding
some	emulation.	Ownership	of	old	software	varies	wildly;	rights	for	individual	titles	may	be	fiercely	guarded,	disputed,	entirely	unknown,	or	even	long	ago	released	into	the	public	domain.	Also,	your	right	to	download	and	use	digital	copies	varies	from	country	to	country.	Even	if	you	own	the	original	hardware	and	software,	you	may	find	yourself
technically	on	the	wrong	side	of	infringement	legislation	unless	you	extract	the	ROMs	yourself.That	all	said,	its	vanishingly	unlikely	youll	get	a	knock	on	the	door	from	the	boys	in	blue	if	you	fire	up	an	old	copy	of	Choplifter	for	Apple	II	on	a	brand-new	MacBook	Pro.Best	Mac	emulators	guide:	Apple	II	emulation	on	macOSPeople	often	forget	many	Apple
II	features	were	based	around	gaming.	The	machines	creator,	Steve	Wozniak,	wanted	the	Apple	II	to	play	a	decent	game	of	Breakout,	in	order	to	impress	his	computer	club	chums.	Hence	this	early	entry	into	home	computing	hardware	came	with	colour	graphics,	sound,	and	joystick	connectivity.The	simplest	way	of	getting	Apple	II	apps	and	games	up
and	running	on	your	Mac	is	to	head	online.	The	Internet	Archive	and	Scullin	Steel	both	have	Apple	II	emulators	that	enable	you	to	load	apps	and	games	in	a	browser.	Generally,	Chromes	the	best	option,	more	successfully	dealing	with	audio	than	Safari.(Long-time	favourite	Virtual	Apple	II	currently	has	issues	in	Safari	and	Chrome,	but	worked	during
testing	in	Firefox,	so	thats	an	alternative	and	it	has	a	huge	selection	of	software	to	try.)If	you	want	a	Mac	app,	your	best	bets	are	Catakigand	Virtual	II.	In	both	cases,	youll	need	to	find	online	or	elsewhere	a	set	of	Apple	II	hardware	ROMs	and	also	relevant	disk	images	(DSK	files)	for	software	you	wish	to	load.Catakigs	main	advantage	is	that	its	free,
and	although	its	not	been	updated	since	2006,	it	works	fine	in	macOS	Sierra.	Put	your	Apple	II	ROMs	in	the	same	folder	as	Catakig	before	startup,	use	Command+N	to	open	a	new	Apple	II,	select	your	model	and	click	Create.	Then	hit	Space	to	give	it	power	and	use	the	Peripherals	menu	to	load	a	disk.If	the	software	doesnt	load,	reboot	the	virtual
Apple	II	from	the	Control	menu,	which	also	houses	speed	controls	to	zoom	through	loading	times	and	boring	bits.	Most	Apple	II	games	offer	keyboard	controls	consult	their	documentation	and	those	that	require	joysticks	can	be	controlled	using	the	mouse	for	directions	and	Command/Option	for	the	two	joystick	buttons.Virtual	II	is	an	entirely	different
beast.	Its	regularly	updated	and	feature-rich,	aiming	to	emulate	the	entire	experience	of	using	an	Apple	II,	including	whirring	disk	noises.	Licences	start	from	16,	and	you	can	evaluate	the	app	prior	to	purchase	albeit	with	a	large	watermark	in	the	window.	From	a	setup	standpoint,	its	no	trickier	than	Catakig:	create	a	new	machine,	click	the	Setup
button,	click	Select	different	ROM	Folder	and	point	the	app	at	where	your	Apple	II	ROMs	reside.	Then	you	can	drag	and	drop	DSK	files	on	to	the	disk	drives	in	the	sidebar.For	games,	Virtual	IIs	superior	to	Catakig,	in	terms	of	configuration:	in	Setup,	go	to	Built-in-Connections	>	Game	Connector.	The	app	uses	your	mouse	by	default	for	a	joystick,	but
the	Keyboard	tab	has	options	to	activate	arrow	keys	instead.	Again,	Command	and	Option	are	used	for	joystick	buttons.Read	next:	How	to	make	retro	games	on	MacBest	Mac	emulators	guide:	How	to	emulate	Macintosh	PlusLike	with	the	Apple	II,	there	are	browser	options	for	running	a	virtual	Macintosh	Plus	on	your	Mac,	such	as	the	one	at
jamesfriend.com.au,	although	theyre	typically	limited	in	terms	of	the	software	you	can	try.	Instead,	Mini	vMac	is	the	emulator	to	use.Setup	is	simple:	find	and	place	vMac.ROM	in	the	same	directory	as	Mini	vMac,	and	then	drag	a	virtual	system	disk	to	the	Mini	vMac	window	when	you	see	the	floppy	disk	icon	with	a	question	mark.	Once	the	virtual	Mac
boots,	you	can	mount	disk	images	(IMG	files)	by	dragging	them	on	to	the	emulated	Macs	desktop.Its	worth	being	mindful	that	old-school	Macs	work	differently	from	current	ones.	Theres	no	two-finger	scrolling	windows,	so	youll	need	to	click	scrollbars;	you	also	need	to	click	and	hold	menus,	because	they	dont	stay	open	when	you	click	one.	Disk
images	also	tend	to	be	happiest	when	you	treat	the	virtual	machine	like	a	real	one,	dragging	them	to	the	Trash	when	youre	done,	and	shutting	down	the	virtual	Mac	with	Special	>	Shut	Down.On	the	app	itself,	its	not	been	updated	for	Retina	displays,	but	that	doesnt	affect	usability.	Also,	theres	no	Command+Q	to	quit,	because	that	would	clash	with
the	virtual	Mac.	To	quit,	therefore	use	Mini	vMac	>	Quit	Mini	vMac.Best	Mac	emulators	guide:	Emulate	Mac	OS	9	with	SheepShaverShould	you	want	to	delve	into	the	Apple	period	between	the	Macintosh	Plus	and	OS	X,	SheepShaver	will	emulate	Mac	OS	7.5.2	through	9.0.4.	Set-up	is	a	touch	more	involved	than	with	earlier	Apple	computers.	Youll
need	a	Mac	ROM,	named	Mac	OS	ROM	and	placed	in	the	same	folder	as	SheepShaver.	Youll	also	need	a	Mac	OS	install	CD,	and	the	relevant	Mac	OS	software	youd	like	to	run.	With	some	judicious	web	searching,	its	possible	to	find	pre-configured	setups	online,	but	should	you	want	to	do	things	yourself,	Emulation.com	has	a	full	guide	to	get	you
started.One	additional	note,	however:	SheepShaver	has	an	odd	quirk	when	running	on	macOS	Sierra.	You	must	copy	the	app	to	the	Desktop,	run	it	once,	delete	the	original,	and	then	move	the	Desktop	copy	back	to	where	the	original	once	lived.	It	should	then	work.	Yes,	its	weird;	just	go	with	it.Best	Mac	emulators	guide:	Emulate	DOS	with
BoxerPlenty	of	modern-day	Mac	users	started	out	on	old	PCs.	However,	running	old	PC	software	on	modern	Macs	requires	DOSBox,	a	capable	but	sometimes	fiddly	and	obtuse	emulator	(in	part	due	to	DOS	itself	being	fiddly	and	obtuse).	A	far	better	bet	is	Boxer,	a	version	of	DOSBox	designed	specifically	for	Macs	and	ease	of	use.The	welcome	window
enables	you	to	browse	existing	games	and	import	new	ones.	The	former	option	opens	~/DOS	Games	in	Finder,	which	is	preloaded	with	a	few	demos	sitting	atop	wooden	shelves.	Double-click	one	to	start	playing	in	a	preconfigured	DOSBox	emulator.	The	location	of	your	games	folder	can	be	adjusted	in	the	General	section	of	Boxers	preferences,	which
also	has	an	option	for	automatically	opening	the	games	folder	on	launch	rather	than	the	welcome	window.To	install	a	new	game,	click	Import	a	new	game	in	the	welcome	window,	or	use	File	>	Import	New	Game.	Drag	your	folder	or	disk	image	to	the	drop	zone	that	appears,	and	then	follow	the	import	instructions.	Once	a	games	installed,	you	can	give
it	a	friendly	name	and	drag	box	art	(easily	found	online)	to	it.On	first	launch,	a	game	will	likely	ask	for	the	specific	file	you	want	to	run.	Usually,	this	is	the	games	name	(possibly	abbreviated	or	truncated)	followed	by	exe.	Boxer	will	ask	whether	you	want	to	do	this	every	time	you	launch	the	title,	meaning	next	time	you	double-click	it	in	Boxers	games
folder,	youll	go	right	to	the	game.Its	worth	noting	that	the	huge	variance	in	classic	PCs	means	Boxer	doesnt	always	get	settings	right.	If	you	need	to	adjust	a	games	speed,	click	the	inspector	button	(the	magnifying	glass)	and	adjust	the	CPU	speed.	Note	that	when	necessary	you	can	also	get	at	important	PC	keys	through	Emulation	>	Simulate	Numeric
Keyboard,	and	Emulation	>	Send	Key.	Some	games	may	also	require	an	old-school	two-button	mouse,	rather	than	the	Magic	Mouse	you	get	with	a	modern	Mac.Best	Mac	emulators	guide:OpenEmu	NES,	Mega	Drive	&beyondOpenEmu	wants	to	change	the	world	of	videogame	emulation,	and	on	the	Mac	its	doing	a	great	job.	Rather	than	you	using
individual	emulators,	many	of	which	havent	been	fully	optimised	for	Mac,	OpenEmu	bundles	everything	into	a	single	brilliantly	designed	app.	This	then	becomes	your	central	point	for	emulating	a	slew	of	systems,	from	those	by	Atari,	Nintendo,	Sega	and	Sony	through	to	lesser-known	hardware	like	Vectrex	and	WonderSwan.On	first	run,	you	confirm
installation	of	required	system	cores,	before	the	main	Library	window	appears.	On	the	left:	your	installed	consoles.	On	the	right:	a	massive	drop	zone,	inviting	you	to	Drag	and	Drop	Games	Here.	Act	accordingly	and	the	game	files	are	copied	to	OpenEmus	library,	in	a	similar	manner	to	how	iTunes	deals	with	media	files.	Sometimes,	a	Resolve	request
will	appear	at	the	bottom-left	of	the	window	when	file	types	(such	as	BIN)	could	feasibly	work	with	a	number	of	virtual	consoles	click	Resolve	and	use	the	menus	to	select	the	right	system	for	your	files.Choose	a	console	from	the	sidebar	and	youll	see	your	added	games	listed,	many	of	which	will	have	cover	art	automatically	applied.	Double-click	one	to
play.	To	access	and	also	redefine	controls	for	the	current	system,	open	the	Controls	tab	from	OpenEmus	preferences.Note	that	with	some	systems,	youll	need	additional	files	to	get	them	working	BIOS	files	from	the	original	hardware.	The	System	Files	tab	in	OpenEmus	preferences	provides	specifics	and	the	filenames	of	required	items.	Once	armed
with	a	copy,	drag	it	to	the	preferences	window.	The	relevant	warning	sign	will	become	a	tick,	meaning	you	can	now	play	games	for	that	system.Best	Mac	emulators	guide:	Emulate	arcade	games	with	MAMEHaving	started	life	as	a	Pac-Man	emulator	in	1997,	MAME	has	grown	into	a	project	that	aims	to	preserve	the	entirety	of	arcade	game	history	of
the	coin-operated	variety.	A	rather	nice	side	effect	is	being	able	to	play	said	games	if	you	install	MAME.On	Mac,	there	have	been	several	distinct	MAME	releases	over	the	years,	and	now	were	sadly	some	way	from	OpenEmus	friendliness.	Even	so,	MAME	isnt	too	awful	to	get	up	and	running.	First,	grab	SLD2	from	libsdl.org	and	drop	it	into
/Library/Frameworks	or	~/Library/Frameworks	(creating	the	Frameworks	folder	first	if	it	doesnt	already	exist).	Next,	download	the	precompiled	MAME64	from	ChoccyHobNob.	Games	for	MAME	should	be	left	as	ZIP	files	and	placed	in	the	roms	folder	(although	you	can	choose	another	location	if	you	like).Fire	up	MAME64.	Its	a	Unix	app	rather	than	a
native	Mac	one,	and	the	interface	is	a	bit	clunky.	Double-click	on	Configuration	Options,	then	Configure	Directories,	and	then	ROMs,	and	point	the	app	at	the	folder	where	your	ROMs	reside.	If	you	want	to	stop	MAME64	displaying	in	full-screen,	go	to	Video	Options,	and	set	Window	Mode	to	On.	Click	Save	Configuration.To	load	a	game	from	the	main
menu,	double-click	it.	You	can	quickly	filter	the	menu,	Spotlight-style,	by	typing	the	name	of	a	game.	Once	a	game	has	loaded,	5	inserts	a	virtual	coin	(these	are,	remember,	virtual	coin-ops),	and	1	starts	a	single-player	game.	Typically,	arrow	keys	are	used	for	directional	control	and	Mac	modifier	keys	(Command,	Option,	Control,	Shift)	for	action
buttons,	but	you	can	examine	full	controls	by	pressing	Tab	in-game	and	choosing	Input	(this	Machine).Note	you	may	sometimes	find	MAME64	opens	to	a	black	screen	and	a	Terminal	window	will	complain	about	video	settings.	If	that	occurs,	open	~/Library/Application	Support/mame/mame.ini	in	a	text	editor.	Under	OSD	VIDEO	OPTIONS,	set	video	to
OpenGL.Best	Mac	emulators	guide:	How	to	emulate	C64Still	listed	as	the	highest-selling	single	computer	model	of	all-time,	the	C64	was	huge	in	the	1980s,	with	a	wealth	of	amazing	games,	many	of	which	still	stand	up	today.	On	macOS,	you	can	choose	between	VirtualC64	and	VICE,	the	former	being	more	Mac-like	and	the	latter	more
flexible.VirtualC64	needs	C64	ROMs	dragging	to	it	on	startup,	after	which	point	you	can	drag	disk	(D64)	and	tape	(T64)	images	to	the	emulator.	Command+D	loads	a	directory	from	disk,	and	you	can	type	List	and	hit	Return	to	see	whats	on	it.	To	load	the	first	file,	use	Command+L,	then	Return,	and	then	type	Run	and	hit	Return	to	start
playing.Commodore-specific	keys	live	in	the	Keyboard	menu.	Under	Emulator	setup,	you	can	adjust	the	colour	palette	and	filter,	and	define	keysets	for	controlling	joysticks	using	your	keyboard	simply	press	a	button	and	then	the	relevant	key.	You	can	then	select	a	keyset	from	the	Port	A	or	Port	B	menu.	(Most	C64	games	require	the	latter.)With	VICE,
X64	is	the	C64	app,	and	there	are	no	ROM	requirements.	Under	Settings	>	Joystick,	you	define	keysets	press	your	desired	key	first,	and	then	choose	a	slot	by	clicking	a	button.	Under	Options	>	VICII,	you	can	adjust	the	visual	filter.	To	load	a	game,	you	can	usually	drop	a	disk	image	right	on	to	the	C64	window.	Also,	note	that	Command+W	doesnt
close	the	virtual	C64	instead,	it	enters	a	warp	mode,	which	proves	handy	for	zooming	past	boring	bits.Best	Mac	emulators	guide:	How	to	emulate	ZX	Spectrum	&Commodore	AmigaIn	the	UK,	the	ZX	Spectrum	was	the	main	competitor	to	the	C64,	and	its	ably	emulated	with	Fuse.	Youll	need	to	increase	the	virtual	machines	screen	size	using	the	View
menu,	unless	you	enjoy	playing	games	on	stamp-sized	windows.	Then	load	a	game	via	File	>	Open	File.One	minor	snag	with	Fuse	is	joysticks	can	be	convoluted	to	set	up	and	prone	to	going	wrong.	On	that	basis,	its	best	to	control	games	using	keys	rather	than	a	virtual	joystick	(and,	frankly,	old-school	Spectrum	users	would	have	it	no	other	way
anyway);	if	youre	using	Z80	game	files	rather	than	TZX	or	TAP,	hit	None	if	they	come	with	preconfigured	control	options.Our	nextsystem	of	choice	is	the	Commodore	Amiga,	a	superb	machine	fans	somehow	wished	might	have	survived	to	today	brush	shoulders	with	the	Mac	and	PC.	Youll	need	FS-UAE	to	run	Amiga	software	on	your	Mac,	along	with
Amiga	kickstart	files.	(These	can	be	bought,	fully	legally,	from	Amiga	Forever.)	1.3	is	a	good	bet	for	games.Bung	your	kickstart	files	in	~/Documents/FS-UAE/Kickstarts/,	and	disks	(ADF)	in	the	Floppies	directory,	and	then	open	FS-UAE.	Click	the	ROM	&	RAM	tab	(fifth	across	looks	like	a	black	chip),	and	select	your	kickstart	ROM.	Back	on	the	home
tab,	select	a	disk	image	for	your	floppy	drive	by	clicking	the	document	icon	and	choosing	a	file.	Then	click	the	Start	button.This	will	launch	the	separate	FS-UAE	app,	which	has	a	smattering	of	its	own	options	that	are	accessed	by	prodding	F12.	The	arrow	keys	and	the	right-hand	Option	key	emulate	a	joystick;	many	Amiga	titles	also	support	the	mouse
although	like	with	PC	games,	you	might	be	better	off	kitting	yourself	out	with	one	that	has	multiple	buttons.Best	Mac	emulators	guide:How	to	emulate	BBC	MicroFinally,	being	that	were	a	British	site,	we	couldnt	ignore	the	BBC	Micro.	Created	by	Acorn	for	the	BBC	Computer	Literacy	Project,	the	machine	ended	up	in	80	per	cent	of	British	schools.	(If
our	experience	was	anything	to	go	by,	the	things	were	broadly	ignored	by	teachers,	and	mostly	used	by	kids	when	it	was	pouring	down	during	lunchtime	and	only	to	have	another	crack	at	Frogger	rip-off	Hopper	rather	than	to	delve	into	educational	software.)On	the	Mac,	your	best	bet	to	get	a	virtual	BBC	Micro	up	and	running	is	BeebEm.	The
emulator	lacks	Retina	support,	and	on	install	requires	the	same	weird	dance	as	SheepShaver	(copy	the	app	to	the	desktop,	run	it,	then	replace	the	original	with	the	one	from	your	desktop).	But	after	that	point,	you	can	double-click	a	disk	image	(SSD	file)	in	Finder	to	load	it	into	a	new	virtual	Beeb.	The	emulator	even	comes	with	a	few	games	in	its
diskimg	folder	fire	up	Games.ssd	and	Chuckie	Egg	for	some	classic	platforming	action.Best	Mac	emulators	guide:	Whats	next?And	thats	it!	Or	rather	it	isnt,	because	there	are	load	of	other	systems	you	can	also	emulate	on	your	Mac,	but	were	already	way	over	word	count	and	our	editor	is	getting	annoyed	were	knee-deep	in	another	game	of	Boulder
Dash	rather	than	filing	this	article.	Still,	if	youd	like	us	to	cover	specific	emulators	in	future	or	any	of	the	above	in	more	depth	let	us	know.	(Once	weve	finished	Cave	M	and	got	Rockford	to	safety,	of	course.)	Whether	you	have	an	Apple	Silicon	Mac	or	are	thinking	of	buying	one,	you	should	know	that	Apple's	new	processors	are	great	for	emulation
purposes.	Whether	it's	modern	3D	consoles	or	2D	classics,	the	sheer	quantity	of	native	Apple	Silicon	emulators	is	something	to	be	celebrated.	Why	Bother	With	Emulation?	The	Mac	is	not	seen	traditionally	as	a	gaming	platform.	Despite	efforts	to	turn	that	around	with	support	for	Apple	Arcade,	iPhone	and	iPad	apps	on	the	desktop,	and	a	handful	of
third-party	publishers	releasing	games	on	Steam	and	the	Mac	App	Store,	the	Mac	still	misses	out	on	the	vast	majority	of	games.	With	the	arrival	of	Apple	Silicon	in	2020,	the	Mac	hopped	from	the	64-bit	x86	architecture	used	by	Intel	chips	to	an	ARM-based	in-house	solution	in	the	form	of	the	M1.	Apple	provided	a	"transpiler"	which	converts	most	apps
written	for	Intel	Macs	into	a	format	that	can	be	used	on	the	ARM-based	processors,	called	Rosetta	2.	While	Rosetta	2	works	remarkably	well	most	of	the	time,	it's	not	a	perfect	solution.	There's	a	performance	penalty	for	converting	an	app,	and	not	everything	works.	Some	apps	(and	games)	simply	won't	run,	and	there's	nothing	you	can	do	about	it
except	hope	that	the	publisher	will	see	fit	to	update	the	app	in	time.	For	most,	this	will	never	happen.	Despite	huge	performance	gains	over	Intel	chips	and	better-than-ever	3D	performance	as	Apple	iterates	on	the	Metal	hardware-acceleration	API,	gaming	on	Apple	Silicon	has	been	slow	to	get	off	the	ground.	This	is	precisely	why	you	might	want	to
look	at	games	that	have	already	been	released	for	different	systems.	Emulators	let	you	play	games	written	for	different	hardware	using	software	emulation.	On	a	Mac,	this	opens	up	a	world	of	gaming	to	you	that	is	simply	not	available	natively.	It's	ideal	if	you	missed	out	on	consoles	or	gaming	platforms	when	they	were	first	released	since	stable
emulators	tend	to	lag	the	generation	they're	emulating	by	a	decade	or	more.	Of	course,	no	article	about	emulation	would	be	complete	without	making	it	clear	that	emulators	are	not	illegal	but	downloading	copyrighted	material	that	you	don't	own	certainly	is.	Many	of	these	emulators	require	BIOS	files	that	will	need	to	be	dumped	from	the	original
hardware,	so	make	sure	you	understand	the	legal	repercussions	of	using	ROMs	before	you	proceed.	When	the	M1	chip	first	launched	in	2020,	very	few	emulators	had	native	Apple	Silicon	versions	available.	Most	used	Apple's	Rosetta	2	transpiler,	with	varying	degrees	of	success.	Fast	forward	to	the	release	of	the	M2,	and	there	are	plenty	of	emulators
available	with	native	Apple	Silicon	support.	With	a	native	app,	the	full	power	of	the	M1,	M2,	and	similar	chips	can	now	be	used	by	the	emulator	and	many	even	include	support	for	Metal.	More	efficient	native	apps	deliver	improved	power	efficiency,	which	makes	gaming	on	a	battery	using	a	MacBook	even	more	attractive.	Emulators	that	require	more
power	to	emulate	more	recent	platforms	like	the	Xbox	and	PlayStation	2	can	now	run	with	better-than-native	graphics.	Many	of	these	emulators	include	the	ability	to	run	games	are	far	higher	internal	resolutions	than	they	were	ever	intended	for,	with	support	for	local	and	online	multiplayer.	Nintendo	Wii	(2006)	and	GameCube	(2001):	Dolphin	Dolphin
is	a	Nintendo	Wii	and	GameCube	emulator	with	Mac,	Windows,	and	Linux	versions	available.	Developers	first	demonstrated	Apple	Silicon	support	in	May	2021,	noting	that	"M1	hardware	is	fantastic	...what	we	have	is	already	efficient,	powerful	...the	only	big	downside	is	the	proprietary	graphics	API	present	in	macOS	that	prevents	us	from	using	the
latest	versions	of	OpenGL."	At	the	time	of	writing,	Dolphin	boasts	36.6%	"perfect"	and	60.4%	"playable"	ratings	for	all	games	tested.	Check	out	the	compatibility	list	to	see	how	each	game	fares,	with	ratings	and	reports	from	across	the	Dolphin	community.	You	can	use	the	Dolphin	performance	guideto	get	the	most	out	of	the	emulator,	but	you'll	likely
have	enough	performance	in	the	bag	to	make	use	of	some	of	Dolphin's	enhancements.	This	includes	an	internal	resolution	bump	to	render	games	in	a	crisp	resolution	that	exceeds	the	480p	Wii	baseline,	anisotropic	filtering	to	make	textures	look	better,	and	options	for	anti-aliasing	to	get	rid	of	jagged	lines.	You	can	use	a	real	Wiimote	and	GameCube
controllers,	or	emulate	Nintendo's	controllers	using	alternative	hardware	instead.	Xbox	(2005):	xemu	Microsoft	has	put	in	a	lot	of	work	to	get	many	original	Xbox	games	running	on	the	latest	Xbox	Series	hardware,	but	the	catalog	still	falls	short.	While	games	like	Psychonauts	and	BLACK	work	well	on	the	latest	consoles,	many	games	do	not	run	at	all.
If	you	don't	own	a	recent	Xbox,	your	options	for	playing	many	of	these	classics	are	sorely	limited.	Step	in	xemu,	an	original	Xbox	emulator	for	Mac,	Windows,	and	Linux.	At	the	time	of	testing,	xemu	deems	72%	of	tested	titles	as	"playable"	with	only	3%	clearing	the	"perfect"	barrier	(with	20%	of	titles	managing	to	start	and	around	5%	not	working	at
all).	Thankfully,	the	vast	majority	of	the	best	Xbox	titles	are	perfectly	playable	with	only	minor	glitches.	This	includesJet	Set	Radio	Future	(which	looks	stunning	when	you	bump	up	the	internal	resolution	thanks	to	its	cel-shaded	graphics),Halo:	Combat	Evolved	and	its	sequel,	andKnights	of	the	Old	Republic.	The	emulator	even	supports	automatic
controller	mapping	for	supported	joypads,	further	simplifying	the	setup	process.	PlayStation	2	(2000):	AetherSX2	PCSX2	is	a	PlayStation	2	emulator	that's	been	in	development	for	at	least	two	decades,	and	AestherSX2	is	a	fork	of	that	same	emulator	for	Apple	Silicon	machines.	Since	one	is	based	on	the	other,	the	game	compatibility	list	is	almost
identical	between	them.	PCSX2	has	since	started	including	Mac	builds	among	its	nightly	releases,	but	these	still	use	Rosetta	2	and	don't	run	natively	on	Apple	Silicon	(yet).	With	AetherSX2,	you	can	play	one	of	the	most	celebrated	and	jam-packed	libraries	of	games	ever	released.	PCSX2	boasts	a	97.96%	playable	rate	for	all	tested	games	at	the	time	of
writing,	and	you	should	expect	very	similar	results	from	AetherSX2	since	it's	based	on	the	same	code.	The	two	emulators	look	remarkably	similar	in	terms	of	UI,	from	the	graphical	options	(that	include	internal	resolution	scaling	and	bilinear	filtering)	to	the	controller	setup	and	system	tweaks.	The	main	difference	you	can	expect	is	better	performance
in	the	native	AestherSX2	build.	Dreamcast	(1998):	Flycast	The	Dreamcast	is	one	of	the	most-celebrated	consoles	ever,	yet	its	failure	to	grab	a	large	chunk	of	the	market	(and	the	dismal	performance	of	its	predecessor,	the	Saturn)	saw	Sega	exit	the	world	of	video	game	hardware	for	good.	The	Dreamcast's	legacy	is	its	games	library,	which	includes
some	of	Sega's	best	originals	and	a	hearty	helping	of	arcade	ports.	Flycast	is	a	fork	of	the	successful	but	since	discontinued	Reicast	project,	with	builds	made	especially	for	Apple	Silicon	machines.	In	addition	to	original	Dreamcast	games,	Flycast	can	also	be	used	to	play	Sega	NAOMI	(including	GD-ROM	versions)	and	Sammy	Atomiswave	arcade	board
ROMs.	Once	configured	the	emulator	runs	many	games	flawlessly,	including	Jet	Set	Radio,Power	Stone,	andSonic	Adventure.	The	emulator	picked	up	our	Xbox	Series	X	controller	first	time,	with	no	configuration	required.	The	emulator	is	pre-configured	to	useDreamcast	Live	servers	for	online	games.	MS-DOS:	DOSBox	with	Boxer	DOS	is	nowhere
near	as	resource-intensive	as	many	of	the	other	systems	on	this	list,	but	native	Apple	Silicon	support	is	still	nice.	A	more	efficient	build	that	runs	natively	means	better	power	consumption	and	longer	battery	life	if	you're	looking	to	play	games	on	the	go.	You	can	grab	a	native	build	of	DOSBox	and	configure	it	yourself,	or	you	can	make	things	much
easier	by	downloading	the	Boxer	front-end.	This	makes	installing	and	managing	your	MS-DOS	game	collection	easier	than	doing	it	manually	with	the	DOS	command	prompt,	with	an	attractive	"game	shelf"	front-end	being	the	main	draw.	The	original	Boxer	project	ceased	development	in	2016	but	has	since	been	revived	with	native	Apple	Silicon
support.	You	can	grab	early	builds	from	the	projectreleases	page,	but	expect	some	wonky	behavior	while	the	project	is	still	in	beta.	Commodore	Amiga:	FS-UAE	Just	like	MS-DOS,	the	Commodore	Amiga	platform	is	hardly	a	resource-hog.	Native	Apple	Silicon	support	here	doesn't	solve	massive	performance	bottlenecks,	but	it's	nice	to	have	native
versions	available	for	efficiency	purposes.	FS-UAE	is	a	fork	of	the	WinUAE	project	and	lets	you	emulate	a	huge	range	of	Commodore	hardware,	provided	you	have	the	Kickstart	ROMs.	You	can	use	modern	gamepads,	create	custom	Amiga	machines	based	on	your	configuration,	and	use	aspect	ratio	correction	to	display	games	on	modern	displays,	with
advanced	shaders.	There's	even	support	for	online	play!	Multiplatform:	RetroArch	RetroArch	is	a	multiplatform	emulator	with	support	for	a	huge	number	of	systems	(known	as	cores).	Many	of	the	projects	listed	above	can	be	used	from	within	RetroArch,	alongside	many	more	for	platforms	like	the	SNES,	Sega	Genesis,	Nintendo	3DS,	Atari	Lynx,	and
many	more.	If	you	need	an	emulator	that	does	it	all,	grab	yourself	a	copy	of	RetroArch	and	spend	some	time	setting	it	up.	Just	because	an	emulator	doesn't	have	a	native	Apple	Silicon	version	available,	that	doesn't	mean	that	older	builds	designed	for	Intel	processors	won't	work.	In	particular,	older	systems	should	run	just	fine	under	Rosetta	2,	with	no
visible	performance	penalty	to	speak	of.	macOS	supports	all	major	console	controllers	including	Microsoft's	Xbox	Series,	Xbox	One,	and	Xbox	360	wired.	You	can	also	use	Sony's	DualSense	PS5	controller	and	the	DualShock	4	PS4	controller,	and	the	DualShock	3	PS3	controller.You	can	also	use	the	Nintendo	Switch	Pro	Controller,	or	pair	each	Joy-Con
separately.	It's	not	currently	possible	to	use	two	Joy-Con	as	a	single	controller	as	is	possible	on	the	Switch	console.	Microsoft	Many	of	these	emulators	automatically	detect	your	controller	and	map	the	buttons	accordingly,	so	you	don't	need	to	do	anything	beyond	connecting	them	via	USB	or	Bluetooth.	The	10	Best	Emulators	for	Mac	Gaming	With	the
rise	of	retro	gaming	and	the	nostalgia	associated	with	classic	console	games,	many	gamers	are	turning	to	emulators	to	play	their	favorite	titles	on	their	Mac	computers.	Emulators	are	software	programs	that	allow	users	to	run	games	from	older	consoles	on	modern	devices,	enabling	them	to	experience	the	joy	of	classic	gaming	on	their	Macs.	In	this
article,	we	will	explore	the	10	best	emulators	for	Mac	gaming,	covering	a	range	of	systems	and	providing	an	overview	of	their	features,	compatibility,	and	performance.	OpenEmu	is	one	of	the	most	popular	emulators	for	Mac	gaming,	offering	support	for	a	wide	range	of	consoles,	including	NES,	SNES,	Game	Boy,	Sega	Genesis,	and	more.	The	emulator
features	a	user-friendly	interface	that	allows	users	to	easily	browse	and	organize	their	game	library,	as	well	as	customize	controller	mappings	and	settings.	OpenEmu	also	supports	save	states,	allowing	players	to	save	their	progress	at	any	point	in	the	game	and	resume	playing	later.	RetroArch	is	a	powerful	and	versatile	emulator	that	supports	a	wide
variety	of	consoles,	including	NES,	SNES,	Sega	Genesis,	and	more.	The	emulator	features	a	modular	design	that	allows	users	to	load	different	cores	(emulators)	for	each	console,	providing	flexibility	and	customization	options.	RetroArch	also	supports	shaders,	allowing	users	to	enhance	the	visual	quality	of	their	games	with	filters	and	effects.	Dolphin
is	a	popular	emulator	for	Nintendo	GameCube	and	Wii	games,	offering	high	compatibility	and	performance	on	Mac	computers.	The	emulator	features	support	for	HD	graphics,	allowing	users	to	play	their	favorite	games	in	high	resolution.	Dolphin	also	supports	a	variety	of	controller	options,	including	GameCube	and	Wii	controllers,	as	well	as	custom
mappings	for	other	input	devices.	MAME	(Multiple	Arcade	Machine	Emulator)	is	a	classic	emulator	that	allows	users	to	play	arcade	games	on	their	Mac	computers.	The	emulator	supports	a	vast	library	of	arcade	games	from	various	systems,	including	classics	like	Pac-Man,	Street	Fighter,	and	Mortal	Kombat.	MAME	also	features	customizable
controls,	allowing	users	to	map	their	keyboard	or	controller	inputs	to	match	the	original	arcade	cabinet	layout.	PCSX2	is	a	PlayStation	2	emulator	for	Mac	that	allows	users	to	play	their	favorite	PS2	games	on	their	computers.	The	emulator	features	high	compatibility	and	performance,	supporting	a	wide	range	of	PS2	titles	with	smooth	gameplay	and
graphics.	PCSX2	also	supports	custom	resolutions	and	texture	filtering,	allowing	users	to	enhance	the	visual	quality	of	their	games.	PPSSPP	is	a	PSP	(PlayStation	Portable)	emulator	for	Mac	that	allows	users	to	play	PSP	games	on	their	computers.	The	emulator	features	high	compatibility	and	performance,	supporting	a	vast	library	of	PSP	titles	with
smooth	gameplay	and	graphics.	PPSSPP	also	supports	custom	resolutions	and	texture	filtering,	allowing	users	to	enhance	the	visual	quality	of	their	games.	Citra	is	a	Nintendo	3DS	emulator	for	Mac	that	allows	users	to	play	3DS	games	on	their	computers.	The	emulator	features	high	compatibility	and	performance,	supporting	a	variety	of	3DS	titles
with	smooth	gameplay	and	graphics.	Citra	also	supports	custom	resolutions	and	texture	filtering,	allowing	users	to	enhance	the	visual	quality	of	their	games.	DeSmuME	is	a	Nintendo	DS	emulator	for	Mac	that	allows	users	to	play	DS	games	on	their	computers.	The	emulator	features	high	compatibility	and	performance,	supporting	a	wide	range	of	DS
titles	with	smooth	gameplay	and	graphics.	DeSmuME	also	supports	custom	resolutions	and	texture	filtering,	allowing	users	to	enhance	the	visual	quality	of	their	games.	Cemu	is	a	Wii	U	emulator	for	Mac	that	allows	users	to	play	Wii	U	games	on	their	computers.	The	emulator	features	high	compatibility	and	performance,	supporting	a	variety	of	Wii	U
titles	with	smooth	gameplay	and	graphics.	Cemu	also	supports	custom	resolutions	and	texture	filtering,	allowing	users	to	enhance	the	visual	quality	of	their	games.	ScummVM	is	a	classic	point-and-click	adventure	game	emulator	for	Mac	that	allows	users	to	play	classic	titles	like	Monkey	Island,	Day	of	the	Tentacle,	and	Sam	&	Max	on	their	computers.
The	emulator	features	high	compatibility	and	performance,	supporting	a	vast	library	of	adventure	games	with	smooth	gameplay	and	graphics.	ScummVM	also	supports	custom	resolutions	and	texture	filtering,	allowing	users	to	enhance	the	visual	quality	of	their	games.In	conclusion,	emulators	offer	a	convenient	and	fun	way	for	Mac	users	to
experience	classic	console	and	arcade	games	on	their	computers.	Whether	youre	a	fan	of	retro	gaming	or	looking	to	revisit	old	favorites,	the	10	emulators	listed	above	provide	a	diverse	range	of	options	for	gaming	on	your	Mac.	From	classic	NES	and	SNES	titles	to	modern	PlayStation	and	Wii	games,	theres	something	for	every	gamer	to	enjoy	with
these	top	emulators	for	Mac	gaming.	If	youre	struggling	to	find	anything	worth	playing	on	your	Mac,	why	not	look	to	the	classics	instead?	Here	are	the	best	emulators	you	can	use	to	play	old	games	on	your	modern	Mac.	Emulators	Are	Legal,	Downloading	ROMs	Is	Not	The	software	that	makes	emulation	possible	is	legal,	hence	the	list	of	projects
linked	below.	But	an	emulator	without	any	ROMs	is	as	useful	as	a	console	without	any	games	to	play.	You	should	be	aware	that	downloading	ROMs	from	the	internet	for	games	you	do	not	own	is	illegal.	None	of	the	projects	below	will	link	to	ROMs,	so	youll	need	to	figure	that	part	of	the	equation	out	for	yourself.	This	is	a	legally	gray	area,	where	it	is
commonly	accepted	that	creating	ROMs	from	copies	of	games	that	you	own	is	permissible.	Some	emulators	even	require	firmware	files	from	the	original	software	to	run,	and	the	expectation	here	is	that	you	will	create	them	yourself.	Learn	what	a	lawyer	had	to	say	about	the	intricacies	of	video	game	ROMs	and	copyright.	1	RetroArch	(Multi-Platform
Emulation)	RetroArch	might	be	the	only	emulator	you	need.	Its	a	multi-system	platform	that	integrates	emulators	into	a	single	piece	of	software,	with	a	Universal	binary	that	works	natively	on	both	Apple	Silicon	and	Intel	Mac	models.	These	individual	emulators	are	known	as	cores	and	are	pulled	from	the	most	successful	emulator	projects	on	the	web.
The	beauty	of	RetroArch	is	that	all	of	your	emulation	can	take	place	within	a	single	app,	from	a	single	interface.	You	can	download	cores	within	the	app,	point	RetroArch	at	the	folders	that	contain	your	ROM	files,	and	even	rely	on	the	controller	configurations	(or	remap	them	as	you	please).	As	cores	are	updated,	you	can	update	everything
automatically	from	within	the	app.	RetroArch	is	a	good	choice	for	old	and	new	systems.	It	often	includes	multiple	cores	for	platforms	so	that	you	can	choose	which	you	prefer.	Support	ranges	from	old	Atari	systems	to	the	PlayStation,	Dreamcast,	and	Nintendo	64,	plus	MAME	releases	and	individual	arcade	boards.	There	are	even	some	source	ports
included	for	games	like	Doom	and	Quake	II.	RetroArch	also	supports	netplay,	allowing	you	to	play	multiplayer	titles	over	the	internet	either	via	the	lobby	or	by	manually	setting	a	game	up.	Youll	both	need	to	be	using	an	identical	ROM	to	make	this	work,	and	you	can	even	use	the	feature	to	play	over	a	local	network	instead	of	the	internet.	OpenEmu	is
an	emulation	platform	that	works	much	in	the	same	way	as	RetroArch.	Everything	lives	under	one	roof,	with	separate	emulation	cores	used	to	play	games	from	a	large	variety	of	systems.	The	project	doesn't	get	updates	like	it	used	to,	and	only	Intel-based	binaries	are	available	(but	it	runs	just	fine	through	Rosetta	2	on	Apple	Silicon	Mac	models).
OpenEmu	might	not	be	as	performant	where	it	counts	like	RetroArch	is.	This	might	not	be	such	a	problem,	though,	since	the	emulator	mostly	focuses	on	older	platforms	anyway.	Handhelds	like	the	Sony	PSP	and	Nintendo	DS	make	up	the	most	modern	portable	platforms,	with	the	original	PlayStation	being	the	most	modern	home	console.	You	might
prefer	OpenEmu	to	RetroArch	for	its	UI,	which	feels	a	lot	more	like	a	Mac	app	than	RetroArch	does.	OpenEmu	was	designed	with	a	mouse	in	mind,	with	ROMs	separated	by	system	and	displayed	in	a	tiled	interface.	Adding	ROMs	is	a	simple	case	of	dragging	and	dropping	into	the	app,	and	you	can	rate	your	collection,	take	screenshots,	and	use	save
states	too.	The	app	is	supposed	to	download	the	box	art	for	any	titles	that	you	add,	but	the	feature	does't	always	work	as	advertised.	Considering	how	well	Apple	silicon	hardware	handles	emulation,	it	would	be	nice	to	see	the	OpenEmu	project	get	a	native	Apple	silicon	version.	Delta	isn't	strictly	a	Mac	emulator,	but	it	was	the	first	emulator	to	receive
widespread	success	on	the	iPhone	and	iPad.	Though	it's	not	officially	available	on	the	Mac,	you	can	download	and	run	Delta	for	iPhone	and	iPadDelta	for	iPhone	and	iPad	on	Apple	silicon	Mac	models	from	the	App	Store.	The	big	benefit	to	doing	this	is	that	if	you	already	use	Delta	on	your	smartphone	or	tablet,	you	can	sync	both	versions	using	Delta
Sync	over	Google	Drive	or	Dropbox.	This	will	transfer	games,	save	files,	save	states,	cheats,	skins,	and	controller	mapping	between	devices.	You	can	start	playing	a	game	on	your	iPhone,	pick	it	up	again	on	your	Mac,	and	then	switch	back	to	your	iPhone	while	maintaining	progress	across	all	platforms.	Delta	is	a	multi-platform	emulator	with	a	focus	on
Nintendo	platforms.	You	can	use	it	to	play	NES,	SNES,	and	N64	games	plus	portables	like	the	Game	Boy,	Game	Boy	Advance,	and	Nintendo	DS.	It's	not	as	powerful	as	RetroArch,	but	it	has	widespread	appeal	thanks	to	its	ease	of	use	and	play-anywhere	approach.	As	a	fledgling	PlayStation	3	emulator,	RPCS3	might	just	be	the	most	adventurous	project
on	this	list.	Its	available	as	a	Universal	binary	for	both	Apple	Silicon	and	Intel	Mac	models	and	it	enjoys	playable	compatibility	with	almost	70%	of	tested	PS3	titles.	The	open-source	project	has	been	alive	since	2011,	with	an	initial	public	release	in	2012.	However,	it	wasnt	until	mid-2022	that	RPCS3	received	Mac	support,	with	Apple	silicon	models
performing	especially	well	thanks	to	an	optimized	build.	You	can	consult	the	RPCS3	Quickstart	Guide	to	find	out	what	you	need	to	get	going,	and	how	things	like	installations,	updates,	save	data	management,	and	pre-requisite	files	are	handled.	Like	many	other	emulators,	RPCS3	allows	you	to	customize	the	experience	to	your	liking.	This	includes
pumping	up	the	resolution	or	scaling	quality	back	if	youre	having	performance	problems.	RCPS3s	compatibility	list	shows	that	some	games	are	even	playable	via	netplay	using	RPCN,	which	tricks	the	emulator	into	believing	its	connected	to	PSN.	The	PlayStation	2	had	one	of	the	greatest	game	libraries	of	all	time,	not	to	mention	one	of	the	greatest
startup	chimes	of	all	time.	Thanks	to	PCSX2,	you	can	enjoy	both	of	these	things	from	the	comfort	of	your	Mac.	This	open-source	project	is	available	on	macOS	through	Intel	binaries	that	must	run	through	Rosetta	2.	Almost	98%	of	the	PlayStation	2	library	is	classed	as	playable	but	only	around	1%	of	those	titles	are	perfect	according	to	the	the	PCSX2
compatibility	list.	Fortunately,	you	can	always	ask	on	the	PCSX2	Mac	Support	forum	for	help	to	solve	problems	specifically	related	to	the	Mac	release.	Failing	that,	theres	a	healthy	PCSX2	Wiki	that	can	help	you	optimize	the	emulator.	Like	similar	projects,	you	can	increase	the	rendering	resolution	to	upscale	PS2	games	and	improve	the	overall	visual
quality.	Its	also	possible	to	share	virtual	memory	cards	(and	save	data),	and	create	save	states	so	that	you	can	jump	right	back	into	the	action	without	using	in-game	saving	mechanics.	Play	original	Xbox	games	on	your	Mac	with	xemu,	an	open-source	emulator	that	lets	you	emulate	Microsofts	original	console.	This	is	possible	using	a	universal	binary
that	runs	natively	on	both	Apple	silicon	and	Intel	chips.	As	it	stands,	around	85%	of	titles	achieve	a	playable	or	perfect	rating	on	xemus	compatibility	list.	Before	you	play,	make	sure	you	understand	xemus	pre-requisite	files	requirements,	and	how	to	convert	your	disc	images	into	the	required	XISO	format.	Once	everything	is	set	up,	most	controllers
should	just	work	out	of	the	box,	including	Xbox	One	and	Xbox	Series	controllers,	and	even	DualShock	4	and	DualSense	PlayStation	controllers.	Networking	works	for	system	link	games	and	you	can	pump	up	the	rendering	resolution	for	greater	fidelity.	Some	games,	like	Jet	Set	Radio	Future,	look	surprisingly	sharp	thanks	to	the	art	style	(but	textures
will	look	a	little	soft	and	flat).	Perhaps	one	of	the	most	well-known	emulators,	Dolphin	supports	both	Nintendo	Wii	and	GameCube	games	natively	on	both	Apple	silicon	and	Intel-based	Macs.	Dolphin	is	arguably	one	of	the	most	successful	modern	emulation	projects,	with	more	than	97%	of	tested	titles	being	either	perfect	or	playable	according	to	the
Dolphin	compatibility	list.	Make	sure	you	read	through	the	various	setup	guides	to	understand	what	you	need	to	do	to	improve	performance,	play	games	over	the	internet	via	netplay,	and	set	up	various	accessories,	like	sensor	bars,	for	the	full	experience.	In	addition	to	Wii	and	GameCube	titles,	Dolphin	also	supports	WiiWare	games	that	were
downloadable	via	the	Shop	Channel.	Perhaps	one	of	the	most	compelling	reasons	to	play	with	Dolphin,	rather	than	on	the	original	hardware,	is	the	ability	to	boost	resolution,	apply	anisotropic	filtering,	and	add	anti-aliasing.	Retro	achievements	are	also	available	in	Dolphin,	giving	you	another	reason	to	go	back	and	beat	your	favorite	games	of	the	era.
Dreamcast	games	are	playable	on	your	Mac	via	Flycast,	an	emulator	that	not	only	supports	SEGAs	final	console	but	the	Atomiswave,	Naomi,	and	Naomi	2	arcade	boards.	You	can	download	Flycast	from	the	projects	GitHub	page	or	install	the	emulator	using	Homebrew.	For	the	latter,	youll	first	need	to	download	and	set	up	Homebrew,	then	run	the
following	command	in	Termina:	brew	install	-cask	flycast	What	youll	get	is	a	Universal	binary	designed	for	Intel	and	Apple	silicon	Mac	models	that	runs	many	titles	at	full	speed.	Unfortunately,	there	is	no	official	compatibility	list	for	Flycast,	so	theres	a	bit	of	trial	and	error	involved.	Weve	had	success	playing	Sega	Rally	2,	Sonic	Adventure	2,	and
Metropolis	Street	Racer	with	few	issues.	You	can	boost	the	internal	resolution	to	get	a	crisper	image	at	the	cost	of	performance,	add	anisotropic	filtering,	and	even	force	widescreen	support	in	games	that	didnt	originally	support	it.	The	project	is	still	actively	maintained	and	has	added	retro	achievements	and	force	feedback	support	to	games	like	F355
Challenge	and	18	Wheeler:	American	Pro	Trucker.	Make	sure	to	scan	the	Flycast	Wiki	to	learn	more	about	BIOS	files,	arcade	ROMs,	and	how	to	get	up	and	running	quickly.	DOSBox	is	a	mature	MS-DOS	emulator,	and	DOSBox-X	is	a	fork	of	that	project	that	adds	a	ton	more	features.	Its	available	with	a	Universal	binary	that	runs	excellently	on	Intel	and
Apple	Silicon	chips,	allowing	you	to	run	software	designed	for	DOS	from	the	comfort	of	a	modern	macOS	environment.	DOSBox-X	makes	the	emulator	even	more	powerful	and	convenient	by	adding	support	for	3dfx	Voodoo	graphics	card	emulation,	Glide	rendering,	printing,	networking,	and	more.	You	can	create	configuration	files	and	launch	them	to
quickly	configure	DOSBox-X	for	specific	tasks.	This	includes	the	ability	to	install	Windows	95	or	98	to	a	virtual	hard	drive,	with	which	you	can	play	games	designed	for	Windows	95	and	98.	Performance	is	what	you'd	expect	on	original	hardware	of	the	era	(so	there	may	be	better	ways	to	play	some	of	these	titles),	but	that	doesnt	mean	a	few	hours	spent
with	DOSBox-X	and	some	old	classics	isnt	a	great	way	to	spend	an	afternoon.	If	emulating	the	golden	age	of	PC	gaming	isn't	enough	for	you,	consider	building	a	retro	PC	instead.	The	Commodore	Amiga	might	best	be	known	for	its	contribution	to	the	evolving	music	scene	of	the	1990s,	but	the	platform	also	happens	to	be	chock-full	of	classic	games.
FS-UAE	is	the	only	emulator	youll	need	to	enjoy	them,	and	its	full	of	modern	conveniences	that	make	playing	older	titles	easier	than	ever.	Available	as	a	Universal	binary,	FS-UAE	works	great	on	modern	Apple	silicon	and	Intel	Macs.	The	emulator	relies	on	a	launcher	app	that	runs	first	to	set	up	the	session.	Load	disks	into	virtual	disk	drives,	configure
input	methods,	or	switch	between	different	models	of	computer	in	the	launcher.	When	youre	ready,	you	can	hit	Start	and	FS-UAE	will	spring	to	life	and	execute	your	setup,	complete	with	crunchy	floppy	disk	noises.	FS-UAE	is	a	powerful	emulator,	with	support	for	all	manner	of	virtualized	accessories,	hard	drives,	expansion	and	accelerator	cards,	and
custom	hardware.	Thankfully	theres	a	rich	library	of	FS-UAE	documentation	that	covers	everything	from	dumping	your	old	floppies	to	setting	up	MIDI	devices.	Last	updated:	23FEB2025	(see	Changelog	for	details)	In	this	guide	Ill	show	you	how	to	get	emulation	up	and	running	on	M-series	(Apple	silicon)	Mac	computers	(iMac,	Mac	Mini,	and
MacBooks).	Table	of	ContentsRecommended	accessoriesConsider	OpenEmuEmulationStation	Desktop	Edition	(ES-DE)Add	ROMs	and	BIOSRetroArchSony	PlayStation	PortableNintendo	3DSGameCube	and	WiiSony	PlayStation	2Microsoft	XboxNintendo	Wii	USony	PlayStation	3Nintendo	SwitchChangelog	Recommended	accessories	You	dont	meed
much	in	order	to	run	classic	games	on	your	Mac.	The	primary	thing	youll	need	is	a	controller.	Standard	console	controllers	will	often	allow	you	to	connect	to	Macs	via	X-input;	Xbox	Series,	PS4,	and	PS5	controllers	in	particular	work	great.	If	you	are	looking	for	a	good	retro-friendly	line	of	controllers,	I	would	recommend	either	the	8BitDo	SN30	Pro	or
the	8BitDo	Pro	2.	Both	have	an	X-input	mode	and	will	be	recognized	as	Xbox	controllers,	and	can	generally	be	found	for	under	$50.	If	you	are	using	a	Mac	that	is	constrained	by	internal	storage	(like	the	lowest-price	Mac	Mini	I	used	in	making	this	guide),	then	it	might	be	worth	grabbing	a	USB	flash	drive	to	store	all	of	your	ROM	files.	I	prefer	the
Samsung	USB-C	flash	drives,	since	they	are	small,	reliable,	and	relatively	cheap.	The	256GB	or	512GB	should	be	perfect	for	most	larger	libraries.	Consider	OpenEmu	Before	we	even	get	started	with	the	guide	itself,	it	might	be	worth	considering	OpenEmu	as	an	alternative	option.	This	is	a	sleek,	all-in-one	emulator	app	focused	on	retro	systems	up
through	GameCube,	N64,	and	PSP.	So	if	you	are	only	looking	to	emulate	a	small	library	of	classic	retro	games,	this	app	is	a	great	solution	without	having	to	dive	into	the	weeds	like	were	going	to	for	the	rest	of	this	guide.	To	get	a	look	at	all	of	its	supported	systems	and	other	helpful	hints,	check	out	their	wiki	page.	EmulationStation	Desktop	Edition
(ES-DE)	The	core	of	our	emulation	experience	on	Mac	will	be	anchored	by	ES-DE,	a	frontend	application	that	will	tie	all	of	the	disparate	emulation	apps	together	into	a	shiny	package.	In	order	to	maximize	our	ES-DE	experience,	I	recommend	installing	this	app	BEFORE	you	start	with	the	actual	emulator	apps.	To	get	started,	download	the	MacOS
Apple	version	from	their	website.	The	first	time	you	open	the	app,	it	will	prompt	you	to	choose	where	your	ROM	directories	should	be	created.	If	you	are	using	a	flash	drive,	youll	want	to	point	to	that	(it	will	generally	be	/Volumes/FlashDriveName).	It	will	then	let	you	create	your	directories	and	you	can	quit	the	app.	Now	in	whatever	folder	you
designated	you	should	see	a	bunch	of	ROM	directories.	You	can	open	each	of	those	and	see	a	systeminfo.txt	file	which	will	contain	information	about	the	emulated	system	and	which	file	types	it	accepts.	For	scraping	boxart,	youll	need	a	screenscraper.fr	login,	which	you	can	get	for	free	on	their	website.	If	you	sign	up	for	their	Patreon,	it	will	unlock
faster	scraping	speeds.	For	specific	ES-DE	information	pertaining	to	Macs,	check	out	this	page	from	their	user	guide.	Note	that	some	apps	cant	be	configured	to	work	with	controller	hotkeys.	In	particular,	Cemu,	Ryujinx,	and	Lime3DS	will	require	you	to	use	a	mouse/keyboard	to	exit	out	of	your	game	and	return	to	ES-DE.	One	option	would	be	to	use	a



special	app	to	invoke	keyboard	commands	(like	CMD	+	Q	to	quit	the	emulator	app).	This	blog	post	highlights	some	apps	that	might	work	in	that	regard,	and	Ive	heard	that	Joystick	Mapper	($5)	is	the	most	compatible	of	the	apps	out	there.	click	to	enlarge	Add	ROMs	and	BIOS	Now	that	ES-DE	has	created	our	ROM	directories,	we	can	start	dragging
and	dropping	our	ROM	files.	These	files	are	copyrighted	and	you	are	on	your	own	to	find	them.	If	you	are	not	sure	which	files	to	use,	consult	the	systeminfo.txt	file	found	within	each	ROM	subfolder.	Additionally,	in	the	specific	emulator	sections	below	Ill	discuss	my	favorite	files	for	each	console,	and	any	of	their	specific	quirks.	BIOS	files	are	system
files	required	to	make	certain	consoles	work.	The	diagram	above	is	a	quick	list	of	some	of	the	most	common	BIOS	files.	Like	ROMs,	BIOS	files	are	copyrighted,	and	you	are	on	your	own	to	find	them.	More	BIOS	information	can	be	found	here.	click	to	enlarge	RetroArch	RetroArch	covers	dozens	of	different	consoles,	and	it	is	my	preferred	way	to	play
retro	systems	up	through	PS1,	N64,	Dreamcast,	and	Saturn.	It	has	a	wide	range	of	customization	but	is	also	a	little	daunting.	The	guide	video	above	will	help	you	get	started,	but	I	also	have	a	more	comprehensive	RetroArch	starter	guide	if	you	want	to	get	a	little	more	into	the	weeds.	Because	ES-DE	takes	care	of	the	navigation	and	launching	aspect	of
RetroArch	for	us,	the	main	things	you	have	to	take	care	of	are	hotkeys	and	pointing	the	app	to	your	BIOS	folder.	All	that	is	discussed	in	the	video	above!	Recommended	RetroArch	cores:Arcade	(FinalBurn	Neo)	--	fighting	games	and	beat'em	upsArcade	(MAME	2003-Plus)	--	all-around	arcade	emulationNEC	PCE/TG-16/PCE-CD/TG-CD	(Beetle
PCE)Nintendo	GB/GBC	(Gambatte)Nintendo	GBA	(mGBA)Nintendo	DS	(melonDS)Nintendo	NES	(Nestopia)Nintendo	SNES	(Snes9x	Current	or	BSNES)Nintendo	64	(Mupen64Plus)Sega	Master	System/Genesis/CD	(Genesis	Plus	GX)Sega	32x	(PicoDrive)Sega	Saturn	(Beetle	Saturn)Sega	Dreamcast	(Flycast)SNK	Neo	Geo	(FinalBurn	Neo)Sony
PlayStation	(Beetle	PSX)	Beyond	just	the	cores/systems	listed	above,	there	are	a	ton	of	other	classic	systems	you	can	play	as	well.	Id	recommend	checking	out	the	Libretro	Docs	guide	for	more	information	about	individual	cores	and	systems	(look	in	the	Core	Library	section).	Now	were	going	to	cover	the	standalone	emulator	apps	that	I	use	beyond
RetroArch.	These	are	listed	in	order	of	how	they	are	covered	in	the	video	guide	above.	Sony	PlayStation	Portable	Emulator:	PPSSPPFile	type:	.iso	or	.csoBIOS:	not	required	Setting	up	PSP	is	super	simple,	thanks	to	the	outstanding	PPSSPP	app.	Simply	download	it,	point	it	to	your	ROM	location,	and	then	go	into	the	Settings	to	configure	the	graphics	as
you	like.	Most	Macs	with	Apple	silicon	will	be	able	to	run	all	PSP	games	at	6x	or	higher	resolution	upscale.	This	app	has	support	for	Retro	Achievements,	which	you	can	find	in	the	Settings	>	Tools	section.	Nintendo	3DS	Emulator:	Lime3DSFile	type:	.3ds	(decrypted)BIOS:	not	required	If,	like	me,	youre	a	Mac	user	and	want	to	find	the	best	Mac
emulators	for	playing	your	favourite	Retro	Games	on	the	go,	then	today	is	going	to	feel	like	all	your	birthdays	have	come	at	once.So	many	of	the	articles	that	we	see	about	emulators	focus	on	the	Windows	users	of	the	world.	Its	true	that	there	are	far	more	emulators	for	PC	out	there,	but	there	are	some	choice	programs	for	Mac	aficionados	to	delve
into	too.And	dare	we	say	that	the	top	emulator	in	this	list	is	one	of	our	favourite	programmes	of	all	time.	Plus,	it	looks	very	classy!From	a	sneaky	Windows	work-around	to	wood-effect	backgrounds	and	crisp	Mac	visuals,	weve	put	together	a	list	of	8	of	the	best	Mac	emulators	to	scratch	that	retro	itch.So,	close	your	spreadsheet,	minimise	your	word
processor,	and	get	gaming!8.	Virtual	MachineNow	this	one	might	be	a	bit	of	a	cheat.	But	when	we	are	talking	about	emulation,	doing	a	sort	of	hardware	Inception	trick	is	a	bit	of	the	point,	isnt	it?If	you	have	a	game	or	program	that	you	are	really	hoping	to	run	on	the	MacOS,	one	of	the	easiest	ways	to	do	that	is	to	simply	get	Windows	running	on	your
Mac.With	programs	such	as	Parellels,	VMWare,	or	VirtualBox,	it	is	possible	to	install	a	copy	of	the	Windows	operation	system	on	a	partition	on	your	Mac	and	run	Windows	in	a	well	window.It	does	take	some	technical	know-how	to	get	this	all	setup,	and	it	is	a	process	I	have	never	been	able	to	do.	But	there	are	a	lot	of	people	out	there	with	the	need	to
have	access	to	both	the	MacOS	and	a	Windows	OS	all	in	one	place.	And	virtual	machine	is	a	way	to	do	it.7.	DOSBoxFor	us	oldschoolers	who	had	personal	computers	before	there	was	even	a	Windows	OS	there	was	something	called	MS-DOS.And	there	were	quite	a	few	very	unique	gaming	experiences	to	be	had	back	in	those	days.For	those	hoping	to	go
back	to	that	magical	time,	or	even	for	those	who	were	not	lucky	enough	to	live	it	in	the	moment:	DOSBox	has	got	you	covered.DOSBox	is	free	and	open	source,	and	is	the	best	way	to	emulate	MS-DOS	games	from	the	80s	and	90s.And	yet	another	form	of	emulaton-inception:	Using	a	Mac	to	run	a	program	to	emulate	MS-DOS	to	play	a	game.6.
DeSmuMEThe	Nintendo	DS	is	the	most	popular	handheld	console	of	all	time	and	has	one	of	the	coolest	library	of	games	available.Check	out	our	list	of	the	best	selling	Nintendo	DS	games	if	you	dont	believe	us!But	the	NDS	is	also	notoriously	difficult	to	emulate.	And	for	good	reason	it	has	two	screens!If	you	are	like	me,	and	have	never	owned	a
Nintendo	DS	DeSmuME	can	emulate	the	Nintendo	DS	and	Nintendo	DS	Lite	handheld	game	consoles	with	its	Mac	compatible	program.5.	RedreamWith	its	easy	ready	to	play	approach,	high	definition	rendering,	and	support	for	about	95%	of	the	game	library,	it	is	easy	to	see	why	Redream	is	the	king	of	Dreamcast	emulation.	Even	for	the	Mac!And
while	there	were	only	624	games	ever	released	for	the	console,	the	Dreamcast	was	certainly	not	lacking	in	quality	titles.Just	take	a	look	at	our	huge	list	of	the	best	Dreamcast	games	of	all	time	if	you	need	some	ideas.4.	Dolphin	EmulatorEmulating	the	GameCube	and	the	Wii	are	both	pretty	hefty	orders	on	any	platform.	But	on	the	Mac?Luckily	we	have
Dolphin	Emulator,	claiming	compatibility	at	60%	Playable	and	36%	Perfect	all	in	full	HD!The	Dolphin	Emulator	has	been	in	development	since	around	the	time	the	GameCube	was	released,	and	has	seen	plenty	of	breakthroughs	and	updates	since	that	time.And	gamers	on	the	MacOS	are	lucky	enough	to	have	a	port	now	available	as	well.Take	a	look	at
some	of	the	best	selling	GameCube	games	or	best	selling	Wii	games	and	start	playing	a	few	now!3.	PPSSPPPPSSPP	is	the	best	PSP	emulator	available	to	use	today,	and	the	great	news	is	that	it	works	on	Mac	too!One	of	the	things	that	we	admire	the	most	about	this	emulator	is	that	its	so	simple	to	set	up	and	use.	You	dont	need	a	doctorate	in
neuroscience	to	be	able	to	get	gaming,	and	the	interface	is	very	pleasing	to	the	eye!Plus	the	graphics	are	fantastic,	and	the	emulator	itself	actually	upscales	games	to	make	them	even	clearer	and	slicker	on	your	iMac	or	MacBook.And	youll	also	find	that	PPSSPP	is	pretty	much	the	core	for	every	other	PSP	emulator	out	there	in	the	world	too,	so	you
know	that	its	the	best	of	the	bunch!2.	RetroArchIf	you	know	anything	about	emulation,	you	have	heard	of	it,	and	thats	why	its	on	our	best	Mac	emulators	list.We	have	covered	it	many	times.It	is	widely	considered	one	of	the	absolute	best	all-in-one	emulation	solutions.I	gave	it	the	number	one	spot	on	my	list	of	the	best	emulators	for	PC.	And	for	good
reasonIt	is	a	really	awesome,	full	featured	powerhouse	for	retro	game	emulation.My	only	complaint	is	that	I	personally	dont	connect	with	the	interface.And	for	that	reason,	I	chose	a	different	all-in-one	emulation	program	the	one	that	I	actually	use	on	my	computer:1.	OpenEmuThis	one	was	a	very	easy	choice	for	me.I	am	the	kind	of	guy	who	wants	an
easy	all-in-one	solution	for	my	game	collection.I	dont	want	to	have	to	think	about	what	console,	what	program,	what	settings	blah	blah	blah.	All	I	want	to	do	is	open	up	my	program,	choose	my	game	and	go	go	go!The	absolute	best	and	easiest	emulation	solution	for	users	on	the	MacOS	is	OpenEmu.With	support	for	Atari,	Famicom,	Game	Boy,	Game
Gear,	Neo	Geo,	NES,	Nintendo	DS,	N64,	GameCube,	Sega	Genesis,	Playstation,	PSP,	SNES,	Virtual	Boy	and	WonderSwan	to	name	a	few	this	thing	has	got	it	all	covered.OpenEmu	is	free,	easy	to	setup,	easy	to	use,	supports	external	controllers,	and	just	makes	keeping	your	retro	game	collection	in	one	place	as	easy	as	possible.Presented	in	an	iTunes
style	library,	making	it	intuitive	and	quick	to	find	what	you	are	looking	for	get	get	right	into	the	fun.For	that	reason,	it	is	my	number	one	choice	for	the	best	Mac	emulators	for	retro	gamers.	Skip	to	main	content	Reddit	and	its	partners	use	cookies	and	similar	technologies	to	provide	you	with	a	better	experience.	By	accepting	all	cookies,	you	agree	to
our	use	of	cookies	to	deliver	and	maintain	our	services	and	site,	improve	the	quality	of	Reddit,	personalize	Reddit	content	and	advertising,	and	measure	the	effectiveness	of	advertising.	By	rejecting	non-essential	cookies,	Reddit	may	still	use	certain	cookies	to	ensure	the	proper	functionality	of	our	platform.	For	more	information,	please	see	our	Cookie
Notice	and	our	Privacy	Policy.	
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